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Introduction 

Rockton Software is pleased to bring award-winning Dynamics Report Manager to the Microsoft Great Plains community.  Dynamics Report Manager a powerful and easy way to integrate Crystal Reports with Microsoft Business Solutions Great Plains, Small Business Manager, Small Business Financials, and Microsoft Dynamics GP.  For purposes of this document, all of these products will be referred to as Great Plains.  Unless specifically noted, Small Business Manager and Small Business Financials instructions are the same as Great Plains.

Crystal Reports is recognized as the standard business-reporting tool across the globe because of its high-powered, easy-to-use interface, enabling companies to produce professional reports that can be distributed in almost every electronic media format available.

While Crystal Reports ships with standard Microsoft Great Plains products, end users must often launch a Crystal report through an outside means.  With Dynamics Report Manager, Crystal reports can be launched directly from the Great Plains interface.  Dynamics Report Manager also solves the problem of multiple printer destinations by allowing any report to be sent to any network printer as a global or user-level setting.

With the release of SQL Reporting Services, Microsoft has introduces a new and powerful competitor to Crystal Reports, at a far better pricing model.  Dynamics Report Manager also launches SRS reports, allowing your organization to choose one or both of these powerful tools for your reporting needs.

Dynamics Report Manager also uses new techniques that integrate with any third-party product that is installed with Great Plains software—all without the need for costly cross-dictionary patches or add-ons. 

Dynamics Report Manager capabilities include:

· Printing reports to the screen, direct to a printer, or to a web browser.

· Pulling information from Great Plains or third-party windows and passing them as parameters to a Crystal or SRS report.

· Launching reports from any Great Plains window – including any third-party product window.  

· Grouping sets of reports to launch together in an easy-to-use interface.

· Defining report destinations by user.

· Scheduling
What’s in This Manual

This manual contains the basic instructions needed for the installation and use of Rockton Software’s Dynamics Report Manager.  You will find instructions for:

· Dynamics Report Manager Installation

· Navigating the Options

· Setting up the System

· Printer Maintenance

· Report Maintenance

· Launching Reports and Setting Report Parameters

· Printing Reports

· Lookup Maintenance

If you do not find the information you need in the following documentation, please contact Rockton Software (see page 7). 

Symbols and Conventions

To help you use this documentation more effectively, we have included the following symbols to highlight important information:

	(
	The checkmark symbol points out suggestions and important notes that assist you in installing and using Dynamics Report Manager.



	(
	The warning symbol alerts you to situations in which you should proceed with caution.  Notes highlighted with a warning symbol relate to information that affects your entire system—please read carefully!   



	(
	The “OK” symbol points out helpful tips that can simplify the process and save time. 



	
	· Keyboard keys, specific buttons, file names and menu paths are shown in bold print, such as the Move Right button, the OK key or the setup.exe program. 




Customer Technical Support

Please contact your Great Plains authorized reseller for support on this product.  If you are an authorized reseller of Great Plains software, contact technical support from Rockton Software by phone at (877) 476-2586 or e-mail:  support@rocktonsoftware.com.

Quick Start

For advanced users, or those who want a quick start installation the following checklist is provided:

1. Install Dynamics Report Manager on one workstation.  Installation is a two-step process.  First install the Dynamics Report Manager Launcher for Crystal (a separate download) and THEN install the relevant Dynamics Report Manager version for your Great Plains product.  The second zip file may include executable files that REPLACE those installed by the DRM Launcher for Crystal.
2. Launch Great Plains and log in as system administrator.  The installation window will appear.  Choose Process to complete the installation.  Choose Registration and click Process to enter your registration key.

3. Open the Dynamics Report Explorer from the Reports menu.  Choose the Admin view.  Choose System Settings and specify other administrators, the Crystal Engine, and the path for your SQL Report Server.
4. Choose the Global System Settings in the Dynamics Report Explorer and set up relevant information.
Once the installation is complete, get started quickly by setting up your system in the following order:

1. Reports > Dynamics Report Explorer > Admin View > Admin.  Set up the System Settings, followed by the Report Global Defaults.

2. Reports > Dynamics Report Explorer > Admin View > Printers > New Printer.  Add at least one printer.

3. Reports > Dynamics Report Explorer > Admin View > Reports > New Report.  Define a report.

Once you have a report printing correctly, you can refer to the appropriate sections of this manual on setting up user defaults, printers, and lookups, as well as detailed information on the above steps.

Installation 

1. From the computer you wish to install Dynamics Report Manager, run the Dynamics Report Manager Launcher for Crystal setup.exe file found in the root directory of the installation CD or directory where the Dynamics Report Manager software was downloaded and unzipped.  

	(
	It is recommended that you are not running any other Windows programs when installing this program


2. Follow the prompts of the setup program.  On some installations, you may have to reboot your system.  

	(
	IMPORTANT! During installation, install the Dynamics Report Manager software in the same directory where Great Plains is installed.  If the Dynamics Report Manager default directory is not the same as the Great Plains installation directory, modify the directory.  

If you do not specify the correct directory, Dynamics Report Manager will not function!


3. Install the .cnk file relevant to your Great Plains version, along with any updated executable files (sometimes this file will be present, sometimes it will not be).  Again, this must also be installed to your Great Plains installation directory.

4. Include the new chunk file code into Great Plains by launching Great Plains.  If this is your first workstation, be sure to log in as ‘sa’.
The following message will appear: “New code must be included in the DYNAMICS.SET dictionary.  Do you wish to include new code now?”

Click Yes and a progress bar will display the status of the integrating process until the login window appears.  This message will NOT appear on SBM systems.

This process will modify your DYNAMICS.SET file to include information relating to the Dynamics Report Manager, and the DRM.cnk file will create an DRM.dic file.

This completes the process for workstation installation.  If this is the first workstation in your network on which you are installing Dynamics Report Manager, see the following page for additional instructions. 

First Workstation Instructions

If this is the first workstation in your network on which you are installing Dynamics Report Manager, complete the following steps.  

	(
	You will need to complete these steps only once for your system.  You do not need to perform these steps in each company.  We try to make it easy on you.



1. Log into Great Plains as system administrator, the “sa” account. 

2. The Dynamics Report Manager Setup window will open.  If it does not, you can access this form from the menu by choosing Tools >> Setup >> System >> Dynamics Report Manager Setup.

3. Choose Install/Upgrade and press the Process button.  A prompt will appear stating, “This process will Install and/or Update tables.  It will not harm existing data, but may take several minutes.  Continue?”  Select Yes.  The data tables and navigation menus will be created.

4. Once the installation process is complete, use the Setup window to choose Registration and press Process. 

5. In the Registration window, enter the Registration Key and press the Register Button.

	(
	If you do not have a registration key, this product will only work in the Great Plains Test company.  To obtain a registration key, contact Rockton Software or your authorized reseller of Great Plains products.


Navigation 

During installation, two menu items are added to the Reports Menu, and a Toolbar with three buttons is added.   Choose Reports > Dynamics Report Explorer for the primary access to most features of DRM.  Choose Reports > Scheduled Report Monitor to open the Report Scheduler.  
Additionally, a new Dynamics Report Explorer Toolbar is created.  You can toggle the toolbar by using View >> Toolbars >> Dynamics Report Manager.  The toolbar includes three buttons, and navigate you to the Dynamics Report Explorer, Scheduled Report Monitor, and the Floating Toolbar Palette.
Most Setup is completed using the Admin View of the Dynamics Report Explorer.  From the Admin View, highlight an object in the left tree view.  From there you can double-click an item in the list to the right, or choose the New Button at the bottom when available to create a new object.  You can create new Reports, Launch Points, Printers, and Lookups.
Setup Overview

The most common steps for setting up Dynamics Report Manger include:

· System Setup

· Global Report Defaults

· Printer Maintenance

· Report Maintenance

· Launch Point Maintenance
· (optional) Lookup Maintenance

	(
	All information tracked by Dynamics Report Manager is tracked at the system level.


System Settings
[image: image2.png]B3 Microsoft Busii

Ele Edt Vew Took Transactions Inqury Reports Cords Extras Windows e Debug

sa | Fabrikam, tnc. | 4p1zr2007 | ([[3] 1% (BN R N |
@ x

i

Rfadd 05 view

Task.

] Untitled Window
51 SmartList Buider £l lobal Report Defauls
89 startup £ Diagnostics

B system settings

E] Field Level Security
1 Dynamics Report Manager System Settings.
] Calendar
E] About Dynamics Repart Manager
] Rockton Customer Maintenance
= scharz
E abe
E abe
= scharz
8 User Classes
8 mark
83 Training Usersx

T NewPine |/ EdiPiner 7 pin

& Dynamics Report Manager System Settings [

Report Administrators.

tna Tina
tom tom

Accounts

Account Transactions
Chectbonks

Cystal Report Engine

50L Repot Server Vitual Directoyy

hig://B0B/RieportServer





The System Settings window allows the system administrator to specify Report Administrators and specify the reporting engines for Crystal and SRS reporting.  

Administrators have access to the Admin View of the Report Explorer and can perform all setup operations.  The ‘sa’ account is added to this list during setup and can be removed.  It is recommended to have at least two administrators in the system.

The Crystal Report engine should default to the DRMCI11.exe engine.  Contact support if you are unsure of which engine to use for Crystal reporting.

The SQL Report Server Virtual Directory specifies the URL for the Report Server for your system.  It is important to validate this entry correctly.

Global Report Defaults

[image: image3.png]B3 Microsoft Business Solutions-Great Plains.

Ele Edt Vew Took Transactions Inqury Reports

52| pabrkom, i, | sizpeoer||[50]

Exras Windows Help Debug

B2 B

Rfadd 05 view

= Untiled Window

= Sttt Buder

Startup

= Feld Level Secuiy

1 Dynamics Report Manager System Settings
= Colenr

1 About Dynamics Report Hansger

] Rockton Customer Maintenance
= scharz
E abe
E abe
= scharz
@ User Classes
@ mark

8 Traning Usersic

Accounts

Account Transactions
Chectbonks

5 Dynamics Report Manager Global Report Defaults

Crystal Global Connection Settings
DSN Name [Great Plins §

Switch Data Saurce to use SGL Company Database.

Overide Repot Credentials
Usermame 2
Passward

Default Destination L[] Ask Each Time.
Coystal Repotts Ciystal Viewer
Repotting Services | Web Browser

Report Witer Screen

SOL Report Viewer Options
Zoom | (defeui]
[ Hide Tookbar
[ Collapse Parameter Toobar
[ Hide Parameter Toolbar

[] All Users have Access

Mark Al e
£

€ Lessonu

€ nark

€ naic
08 mars
0og s

€ tna

€ o

M@ iRk

Ciystal PDF Default Path and Filename
chvptpdt

Crystal Viewer Options
Show Export Buttan
Show Group Tree Button
Show Refresh Buttan
Show Select Expert Button
Flemertbe passed Parameters

Ciystal Printer Settings
Piiter 1D
Papersource | (defaul)
Copies 1

Ciystal Page Orientation
Defaut

All Companies have Access

Selected Companies

0
E kAl

T
£ UnmakAl
1 Feiish





The Global Report Defaults allow you to set up templates or defaulted information for most reports in the system.  This is a huge time saver when thoughtfully used with a large number of reports.

Crystal Global Connection Settings  This setting allows you to set up one set of connection information to use for all Crystal Reports across the enterprise.  Most sites use a single SQL user to connect to their data, and by entering it here it will not need to be set up on each report.

Default Destination  Most reports should be printed to screen unless set up for a specific application.  When adding a new report, it’s destination settings are copied from this window and can then be modified.

Other Options  SQL Viewer Options, Crystal PDF Filename, Crystal Viewer Options, Crystal Printer Settings, and Crystal Page Orientation all specify settings that are copied onto a brand new report when it is initially created.  Once a report is created, these settings are not copied from the global setup.

All Users/Companies Have Access  These options allows you to pick and choose which users or companies have access to a report.  These settings are copied to the report during setup and are not used after creation.

Dynamics Report Explorer
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The Dynamics Report Explorer is the primary navigation and viewing screen for both managing and launching reports.  The top above view is the Administrative View, while the lower pane shows the user’s My View.  

All Administrators can toggle between the Admin View and My View using the drop down listing the view options.  If a user is not a Report Administrator, they will be locked into My View only.

The top row of buttons perform the following functions:

	OK Button
	Closes the Explorer

	Options Button
	Opens the User Options window, allowing a user to specify their favorites and specify the application which launches when the FRx button is pushed

	FRx Button
	A user-definable shortcut to launch an external application, specifically designed for FRx Designer or Report Launcher, to allow a user to easily access FRx reporting.  When first pushed, if the shortcut is not specified, the user will be prompted with instructions to navigate to the application they wish to launch.  This can be changed from the User Options screen by pressing the Options Button.
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The User Options window lists all Available Reports on the left side, and a user-defined tree of reports on the right.  By selecting a report on the left, the user can push the >> button to add the given report to the root or a folder on the right.  Any report can appear multiple times in the user favorites.  Favorites appear in the My View tree of the Report Explorer.

Each workstation can also define the FRx application to launch when the FRx button is pushed from the Report Explorer.

Admin View

When in Admin View, the Report Explorer Tree contains five nodes: Admin, Reports, Launch Points, Printers, and Lookups.  Since Reports and Launch Points can contain groupings, these two items contain subsets of their objects to help manage larger data sets.  By navigating to an item or folder on the tree, a list of objects related to that item appear in the list view to the right.  Double-click any item in the list view to edit or access that item.  When given object is selected in the tree, you can also press the New button to create one of those objects.  Finally, specific highlighted Reports and Launch Points can be printed from the Print Button to help test a given setup.

All Reports and Launch Points are available and editable by administrators in this view.

My View

The user’s view lists all reports that for which a given user has access.  The tree view is broken into two nodes, the Reports node and the Favorites node.  The Reports node is further divided into groupings.  The Favorites node is defined by each user and they can specify their own groupings.

In My View, double-clicking on a report in the tree view adds that report to the Current Print List.  Clicking on a folder (except specifically for the All Reports folder) in the tree view will add all reports in that folder to the Current Print List.

Highlighting each report in the Current Print List allows the user to specify parameters and the destination for that report.  Parameters can be specified by selecting a parameter and typing in the value or using the lookup list if a lookup is defined for a parameter.

The available destinations will populate for each report, and the user can choose their destination and specify settings related to that destination.  

When all settings are correct for the given list of reports in the Current Print List, pressing the Print button will launch all of the reports in the list as specified.

Printer Maintenance
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Dynamics Report Manager allows for unlimited network printers to be defined for Crystal reports.  

Printer ID

The Printer ID is used only throughout Dynamics Report Manager and does not reflect the naming convention of a printer set up on a user workstation.  The Printer ID must be unique.

	(
	It is useful to supply names to printers based on their function or location, using all caps.  For instance, ACCOUNTING, WAREHOUSE, and SHIPPING, are all reasonable Printer IDs.  Since the Printer ID is what a user sees when printing, it is useful to use names that your staff can easily associate specific printers with.


Global Printer Name

1. Use the Lookup button to open the Print Setup window.  

2. Select the name of the printer you wish to define and press the OK button.  The name of the printer will display in this field.  It is editable for advanced users.

3. The printer name specified by the workstation through the above selection process is important.  When a report is printed, Dynamics Report Manager resolves the printer destination by an exact name match with listed printers installed on a machine.

	(
	The settings such as paper size and orientation for Crystal reports are NOT saved as part of Dynamics Report Manager.  Settings such as these are defined in each Crystal report.


For some older Windows operating systems, such as Windows 98, printer names can be set up and changed in the printing control panel.  For these machines, it is recommended that all workstations have their printers set up with the same name.  This allows for proper name resolution from all workstations without creating machine-specific settings.  

For some Windows operating systems, such as Windows NT workstations and servers, the printer name is not modifiable.  For these cases, check the box Use This Machine’s Printer Name for this Printer.

	(
	This process must be run at each physical workstation in order to be set up properly.


Machine ID

The Machine ID uniquely identifies each workstation computer.  On a Windows network, the network computer name is an excellent choice as the Machine ID. This allows resolution of a Printer ID to this machine, regardless of which user is logged in.

1. To setup the Machine Printer Name, use the Lookup button to look up available printers on this machine.  

2. Once selecting a printer, you may notice the name is different from the Global Printer Name.

Here is an example of when the Machine Printer option is useful: say Bob has a local printer installed at his workstation that everyone on the network can access.  The Global Printer Name will be the most common name that everyone uses, such as “Network1\BOB\HP4Printer.” While at Bob’s machine, the printer name may be defined in his Control Panel settings as “HP4Printer.” In this case, set up a Printer ID of “BOB” and set the Global Printer Name to the more common name.  At Bob’s machine, select the checkbox, put “BOB” as the Machine ID and “HP4Printer” as the Machine Printer Name.

	(
	The Machine Printer Name does not have to resolve to the same printer as specified in the Global Printer Name.


Report Maintenance
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Report Maintenance is where individual reports are defined and set up.  You can specify a report’s type, it’s display information, parameters, destination, and access from this window.

Report Maintenance contains tabs which divide the setup of a report into subsets of information.  Not all report types can access all tabs.

	Option
	Explanation

	Report ID
	This is a unique identifier of each report.  An abbreviated report name serves as a good ID.

	Report Type
	Specify Crystal, SQL Reporting Services, Great Plains Report Writer, or Custom Dexterity script.  The Customer Dexterity script is for advanced report launching and is not covered in this manual.  For information on how to utilize this feature, please contact Rockton Software.

	Report Physical Name
	The name of the physical report.  For Crystal Reports, this would contain the full path to the report and would also include the .rpt extension.  You can use the Lookup button to select a report from a file dialog box.  For SRS reports, specify the subfolder if needed so that the System Setup report server address, when prefixed to your entry, completes a complete report name and path for the report.  For Report Writer Reports

	Report Display Name
	The name displayed to the user when the report is referenced throughout the system.

	Report Group
	An optional group name you can give reports to help group them into smaller and similar collections.  Groups help sort reports in the Report Explorer window.


Parameters Tab

This tab allows for viewing and entry of Report Parameters.  Specify the number of parameters defined for this report.  The default is 0.  If you increase the number of parameters, parameter records will be added to the parameter list.  If you decrease the number of parameters, excess parameters in the list will be permanently deleted.  For Crystal Reports only, you can import parameters for a report by pressing the Preview button to the right of the Number of Parameters.

Parameter can be re-sequenced using the up and down arrows to the right.  For Crystal Reports, the parameter order is very important and must match the report.  For SQL Reporting Services, the parameter name must match while the order is irrelevant.
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Destination Tab

The Destination Tab allows you to set up the default destination, but also the default settings for any destination should the user change them at print time.  Different Destinations appear depending on the type of report specified.

The Ask Each Time checkbox forces a final parameter entry and destination dialog box to display to the user when they run a report.  This gives greater flexibility to the users when launching reports.

If the Printer ID is blank when printing, then the default printer saved with the report will be used.
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Access Tab

The Access Tab allows the administrator to set security for this report to specified users and companies.  Users appear up to twice in the Selected Users list, once under “(All Users)” and then again if they are in a class.  The class grouping is for convenience only; security is still granted or denied at a per-user level.  Therefore, if a user is added to the system later while a given report has access for a given class, that specific user will not have access to a given report until the administrator grants access.  Of course, choosing “All Users have Access” eliminates this issue and will always allow all users access to the report, including new system users added later.

The Company list behaves similarly.  Only users specified on the left that are logged into marked companies on the right will have access to print this report.  

The default for All Users and All Companies have Access is copied from the Global Report Settings screen during report creation.
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Connection Tab

The Connection information is specific to Crystal Reports.  By default, each report uses the Global Report Defaults connection information.  However, each report can have its own connection properties set here by overriding the Global Connection.

You can specify an alternate DSN, which when specified will override the ODBC connection saved in the report.  If you do not specify this value, the ODBC connection last saved in the Crystal report will be used.  It is critical for connectivity and launching of this report that the ODBC connection used for the report is set up on each workstation that launches it.  It is generally good practice to use the Great Plains ODBC connection or to create a specific connection for Crystal reports.

The Switch Data Source to use SQL Company Database option allows the report to be modified at runtime to point to data in the Great Plains company database.  ALL tables, views, and stored procedures in the report will be redirected to the company database.  Subreports will also be redirected to the company database if this option is chosen.  If you are running a report that has data from the company and system database, it may be best to write a view or stored procedure to consolidate your data into a one location in the company database.  Contact Rockton for more tricks and tips on how to make this work.

The Override Report Credentials sets the username and password for the Crystal Report to connect to the SQL database at runtime.  If it is not specified, then the last saved username in the report will be used, with a blank password.  Crystal does not save passwords in its reports, so if you have a username with a blank password last saved with a report, it will run if that username has no password in SQL.  Most sites require this value to be set.  It is common practice to set up a user name “Crystal” in the SQL database and grant it access to the DYNGRP group, for the purposes of managing Crystal reporting.

Parameter Entry
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The Parameter Entry window is opened by double-clicking a parameter in the Report Maintenance window or highlighting a parameter and pressing the blue arrow zoom button in the upper right of the parameter scrolling window of Report Maintenance.

Details of this screen are listed below.

	Option
	Explanation

	Report ID
	The Report ID for the report on which you are specifying a parameter.

	Sequence
	An index of the parameter.  You can change the index by using the Report Maintenance screen’s Parameter tab to move the parameters up or down in the list, which will re-sort them.  All parameter indexing starts at 1.

	Parameter Name
	The technical name of the parameter.  This must match the parameter name exactly for SQL Reporting Services.  It can but need not match for other reports.

	Parameter Prompts
	A friendly title to help users know what to enter for the parameter.

	Data Type
	The datatype of the parameter, which drives how it behaves and how its default values are collected.  This must match the data type set up in the report.

	Convert to DateTime
	A setting available only to Date or Time parameters, which forces either a Date or Time parameter to a combined DateTime parameter.  The default date portion for a converted Time parameter is Jan 1, 1900.  The default time portion for a converted Date parameter is midnight.

	Lookup ID
	An optional but useful setting to help users enter parameter values.  For instance, if the parameter is designed to collect a Customer Number, use the CUSTOMER pre-built lookup.  Users can use lookups inside of Great Plains to enter correct values.  Dynamics Report Manager comes with over 20 pre-built common lookups, or you can define your own.

	Allow Multiple Values
	Check this box if more than one value can be specified for the parameter.  The parameter in Crystal and SQL Reporting must also support this feature.

	Allow Range Values
	Used only in Crystal, this allows for specifying a range in a single parameter.  In general, it is often more useful to divide a range parameter into two parameters for end-user ease-of-use.


Default Values

The Default Values section allows you to enter default values that will initialize each time a report is run.  It is not necessary to specify defaults.  You can enter calculated values, range values if appropriate, or NULL if needed.  Enter the value or values in the Value field(s) and press the Insert >> button to enter them in the list.  To delete a value, highlight the value in the list and press the << Remove button.
	(
	Each time the report is run from within Great Plains, Dynamics Report Manager will always use the default value you set up here.  Only specify default values if they will not often change.

If you leave the default values blank, each time a user runs the report, Dynamics Report Manager will “remember” the last used values for that user and initialize the report with those values.  This is often more useful for most users during parameter entry.

Any parameter values can be changed when the report is run.  It is often most useful to only specify default values when the default values are the most common choice and do not change often when the report is run.


Lookup Maintenance

Dynamics Report Manager has many pre-built lookups for common objects in Great Plains, including Customers, Vendors, and Accounts.  You can specify your own custom lookups to further enhance the usability of Dynamics Report Manager.  There are three types of Lookups.
· Custom Scripted Lookup  This allows for cross-dictionary access to common standard lookup windows using pass-through scripting.

· Static Lookup  This allows you to enter a fixed list of values, such as days of the week or document types.  It is designed for lists of data that do not change.

· Table Lookup  This allows you to specify a Great Plains or 3rd party table and will perform a dynamic data lookup each time against that table.

Custom Scripted Lookup
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Great Plains allows extensive use of lookups to facilitate data entry. The ability to look up values in a lookup list for a third-party product without the third-party intervention is technically challenging.  You may need to know resources for the lookup you are trying to use.  If you need assistance with a custom lookup, please contact Rockton for support.  

	(
	Lookups can be challenging to set up.  If you have tried setting up a lookup and are unsuccessful, contact technical support for assistance.  As Dynamics Report Manager evolves, more and more common third-party product lookups will be included.


	(
	A wizard feature is now included to assist with creating a custom scripted lookup.  Using this feature is highly recommended.


Most Great Plains applications perform the following steps when a user presses a lookup button:

1. The Lookup Window and Form are opened.

2. An initial value of where to start the lookup list is set (for example, if you are looking up a Customer ID of C45253, you may start the lookup at C4).

3. The sort order drop-down list is set.

4. Additional values are set (for complex lookups).

5. The Redisplay button is pushed.

6. The screen waits for user interaction.

7. If the user presses the Select button, the highlighted value in the scrolling window is returned.

	(
	It is usually helpful to use the resource descriptions found in Tools > Resource Descriptions > Windows.  This will list technical form, window, and field names to assist you in setting up a lookup.


Fill in the following fields to complete a lookup definition.

	Option
	Explanation



	Lookup ID
	A useful name to define the lookup.  Some standard IDs are already in use (such as CUSTOMER and VENDOR) and cannot be used.  If you attempt to use a reserved Lookup ID, Dynamics Report Manager will prompt you to select a different ID.

	Lookup Description
	A user-friendly name for the lookup.

	Product ID, Series, Lookup Form, Main Window
	Use the drop down lists to specify the main form and main window for the lookup form. 

	Scrolling Window
	The scrolling window is often the name of the Main Window appended with “_Scroll”.  You can find the name of a scrolling window by using the Window Resource Descriptions window.  Often there is only one scrolling window on a lookup, and the list will only populate with scrolling windows.
In the Window Resources Descriptions window, select the product, series, and lookup window.  Scroll through the Window Fields list and find an entry that starts with “SW:”  This is the name of the scrolling window for that form and window. (Omit the “SW:” in the name)

	Return Value Field
	In most cases this is the same name used in the Initialize Value Field below.  This field must be in the scrolling window.  It is usually the value you want returned (such as “Customer Number” for a Customer lookup).

	Select Button
	Use the lookup button to select the Select Button field on the Main Window.  In almost all cases, this value will be “Select Button”.

	Initialize Value Field
	(optional) Check the box and specify the field you would like to receive the initial value from your lookup query.  In most cases, this is also the field you want returned (such as “Customer Number” for a Customer lookup).

	Set Sort Value
	(optional)  If you wish to change the default sort value, check this box and enter the name of the field for the Sort By field.  It is often called “Sort By” or “(L) Sort By”.  You can peruse values using the lookup list.  Enter an integer in the Value to Set column to specify which item numerically in the sort list you desire to set.

	Set Values 1, 2, and 3
	(optional)  On some advanced lookups, other window values need to be initialized in order to function properly.  Check the box and enter a field name for the field you wish to initialize.  Enter the value in the Value to Set column.  The Value to Set is a string.  If the string you enter resolves to a numeric data type, a numeric value will be passed.  Otherwise, the literal string will be passed.

	Redisplay Button
	(optional)  Select the field name for the Redisplay Button.  This is almost always “Redisplay Button.”


Once you have defined a Lookup, it is best to test it immediately for proper behavior and usage.  To test the lookup, find a report in Report Maintenance with a parameter that will use the lookup.  In the Parameter Maintenance window, select this Lookup ID to be used for the parameter.  Select the report to print in the Print Reports window, and test the lookup on the parameter that is defined to use this Lookup ID.

	(
	It is possible to receive error messages if the lookup is not configured properly.  Attempt to decipher the error messages and modify the lookup definition.  If you are still unsuccessful at setting up the Lookup, contact support for assistance.




Static Lookup
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Static Lookups enable you to create short lists of static values which do not change much over time.
Enter each value in the Insert Value field and press the Insert button.  To remove a value from the list, highlight the value in the list and press the Remove button.

Table Lookup
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To create a lookup from a SQL table, select the Product, Series, and Table which holds the information you seek.  The value you wish to lookup and return should be specified in the Return Value Field, and additional display values should be specified in the Display Fields 1 and 2.

Keep in mind that very large tables may perform slowly during lookups.  

	(
	It is usually helpful to use the resource descriptions found in Tools > Resource Descriptions > Tables.  This will list technical information about tables in loaded products.


Launch Point Maintenance
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Launch Point Maintenance is where reports or groups of reports are assigned a launching point, such as a shortcut from a window, to be launched.  There are several different launch points, and depending on the type of Launch Point you specify the setup options may vary.  The Description and Optional Group are similar in use to Reports.  Here are the Launch Point Types:
	Launch Point
	Explanation

	Window Extras Menu
	This provides a menu item under Extras >> Additional which can appear for any form throughout Great Plains or any 3rd party product.  

	Toolbar Floating Palette
	The floating palette is a context-sensitive pick list which can be accessed from the Dynamics Report Manager Toolbar.  This palette can be “pinned down” so it does not leave the desktop, and can be moved to any position on the screen where it will remember its placement next time it is opened.  This palette provides a list of reports that shrinks and grows as you open and close specific windows, providing a pick list for reports that are relative to what windows you have open at a given time.

	Window Field or Button
	This provides a trigger point, usually from a button on a window, for which to launch a report.  The print button on a window is a common example, but you can launch a report from a Posting button or when a user enters a dollar amount in a specific field. 

	Shortcut Bar
	Reports can be launched from the regular shortcut bar using this option.

	Desktop Shortcut
	You can create desktop shortcuts to launch Crystal and SQL Reporting Services reports directly from the desktop without having Great Plains open.  This option is only available for Crystal and SRS reports, and the parameters cannot be changed at runtime, as they are preset at the time the desktop shortcut is made.

	Replace Report Writer Report
	When a Report Writer report is launched, you can “replace” it with your own version of the report.  HOWEVER, the existing Great Plains report will still run.  Most reports in Great Plains can be configured to print directly to file, so if you set up the old report to print to file without intervention, the result would be a seamless new report to replace it.

	Scheduled Launch
	Schedule your reports to launch when you want them, and keep a running calendar of when the next time a given report will launch.

	Data Stream
	Not yet implemented, this option will allow you to batch-print and e-mail a report that is dispersed to numerous contacts.

	Home Page
	Not yet implemented, this Great Plains 9.0 option utilizes the Home Page in Great Plains to add items to the My Reports list. 

	
	


Launch Report Maintenance contains tabs which divide the setup of a report into subsets of information.  Not all report types can access all tabs.

Reports Tab

[image: image17.png]Ele Edt Vew Took Transactions Inqury Reports

snzpor | |[Q] 1

sa | Fabriam, Inc.

Cords

Exras Windows Help Debug

=R W s |

Rfadd 05 view

= Untiled Window

= Sttt Buder

Startup

= Feld Level Secuiy

1 Dynamics Report Manager System Settings
= Colenr

1 About Dynamics Report Hansger

] Rockton Customer Maintenance
= scharz
E abe
E abe
= scharz
8 User Classes
8 mark
83 Training Usersx

Accounts
Account Transactions
Chectbonks

I Launch Point Maintenance

W sae | X Dok

Launch Paint D
Launch Point Type
Description
Optionsl Growp

TesT O
Windon Extas Mo
Test Win Etas Meru
Saes

Setings | Heports | Actions

Report Name
Customer List Main

Report ID
custusT

Customer List o Subreport O

Rockton Sales Detal
MyTestRepart1

This Launch Paint Type

SALES TR
TESTSQL

allows for muliple reports

EoX




 

The Reports Tab allows you to set up the reports that print when this Launch Point is activated.  Most Launch Points allow for multiple reports, but it will be noted in the lower portion of the window when only one report can be specified.

When more than one report is specified, you must set up Actions to tell Dynamics Report Manager to launch all reports at once or to launch them individually.

Access Tab
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The Access Tab allows the administrator to set security for this Launch Point to specified users and companies.  Users appear up to twice in the Selected Users list, once under “(All Users)” and then again if they are in a class.  The class grouping is for convenience only; security is still granted or denied at a per-user level.  Therefore, if a user is added to the system later while a given Launch Point has access for a given class, that specific user will not have access to a given report until the administrator grants access.  Of course, choosing “All Users have Access” eliminates this issue and will always allow all users access to the Launch Point, including new system users added later.

The Company list behaves similarly.  Only users specified on the left that are logged into marked companies on the right will have access to this Launch Point. 
The default for All Users and All Companies have Access is checked.

Actions Tab
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The Actions tab allows you to provide specific logic and a sequence of events when you launch your reports.  Using Custom Actions you can often avoid costly customizations for reporting.  Custom actions allow you to launch a pick list, set parameters of reports to values of fields on windows, and also change values on window fields and run processes in Great Plains.  These are very powerful features in Dynamics Report Manager.

Custom Actions are listed below

	Custom Action
	Explanation

	Set Parameter
	This option allows you to set a parameter on a report to a field value on a screen.  This allows you to print reports with parameters that reflect data relevant to what screen you are viewing when the report is launched.  For instance, if you print an Invoice you can specify the Invoice Number parameter in the report to be set to the value on the screen of Invoice Entry.  

	Set Field
	The opposite of Set Parameter, this allows you to set a value of a field on a window to whatever you wish it to be.  This is often used in conjunction with the Run Field Script.

	Run Field Script
	This will run a field change script on a field on a specified window.  It is often used with Set Field to change data on a screen.  It can also run a change script for a Button on a window, such as a Cancel button which will close a given window.

	Check Field Condition
	This allows conditional report launching based on a field value.  For instance, you may only want to launch an Invoice Report from the Sales Order Transaction screen if the Document Type is “Invoice”.  

	Check Window is Open
	This allows conditional report launching based on a window being open or closed.  This is useful to make sure that if you are intercepting Great Plains logic that certain windows are behaving properly in your launch point circumstance.

	Show Report Pick List
	Instead of launching all reports specified in this Launch Point, you can display a pick list of several reports, which will allow the user the option to choose which reports at that moment to print.  This is useful for a situation like Sales Processing, where a pick list from the Print Button will display reports of Invoice, Pick List, and Pack List, and the user can choose one or more to print.

	Launch All Reports
	Once other custom actions are completed (like setting parameters or other logic) you may want to then launch all reports.  This command is offered to make sure the sequence of events is correct.

	Launch Specific Reports
	You can also launch specific reports that have been specified in a certain order based on the flow you wish to achieve.


Action Entry
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The Action Entry window has options based on the Action Type specified.  Most flow logically and behave like other screens documented in this manual.

Rockton Software Dynamics Report Manager, April 2006
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